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Chapter 1.

Introduction

JSF Tools are especially designed for supporting JSF and JSF-related technologies. JSF Tools
provide extensible and exemplary tools for building JSF-based applications as well as adding JSF
capabilities to existing web projects, importing JSF projects and choosing any JSF implementation
while developing JSF application.

In this guide we provide you with the information on JSF tooling which allows you to develop JSF
applications much faster and with far fewer errors so sparing your time.

1.1. Key Features of JSF Tools

Here, we provide you with a key functionality which is integrated in JSF tooling.

Table 1.1. Key Functionality for JSF Tools

Feature Benefit ‘ Chapter
JSF and Facelets Step-by-step wizards for creating new JSF and  jsf support
support Facelets projects with a number of predefined

templates, importing existing ones and adding
JSF capabilities to non-jsf web projects.

Flexible and Jump-start development with out-of-the-box projects
customizable templates or easily customized templates for

project template re-use.

management

Support for JSF Working on file using three modes: diagram, graphical editor for jsf
Configuration File tree and source. Synchronization between the

modes and full control over the code. Easy
moving around the diagram using the Diagram
Navigator.

Support for Managed Adding new managed beans, generating code managed beans

Beans for attributes, properties and getter/setter

methods.
Support for Custom Fast creating of custom converters and converters and
Converters and validators with tree view of faces-config.xml validators
Validators file.
Verification and All occuring errors will be immediately reported verification and
Validation by verification feature, no matter in what view validation

you are working. Constant validation and errors
checking allows to catch many of the errors
during development process that significantly
reduces development time.
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1.2. Other relevant resources on the topic

All JBoss Developer Studio/JBoss Tools release documentation you can find at http:/
docs.jboss.org/tools [http://docs.jboss.org/tools/] in the corresponding release directory.

The latest documentation builds are available at http://download.jboss.org/ibosstools/nightly-docs
[http://download.jboss.org/jbosstools/nightly-docs/].



http://docs.jboss.org/tools/
http://docs.jboss.org/tools/
http://docs.jboss.org/tools/
http://download.jboss.org/jbosstools/nightly-docs/
http://download.jboss.org/jbosstools/nightly-docs/
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JavaServer Faces Support

We don't lock you into any one JavaServer Faces implementation. You can always select the one
which is necessary for you while creating a new JSF project, adding JSF capability to any existing
Eclipse project or importing existing JSF projects as well.

At this point the special wizard will prompt you to specify a proper JSF environment. It may be JSF
1.1.02 Rl or JSF 1.2 which integrates a number of new features and changes. The wizard also
lets you select JSF implementation with a component orientation such as JSF 1.2 with Facelets
or MyFaces 1.1.4.

[€ New |SF Project »®

Create |SF Project @

The Create New Project Wizard is used for creating

a brand new project. If you already have a pre-existing
project, just use the Import Project Wizard to start working
with it in JBoss Tools.

Project Name* [ JSFFProject ]

/] Use default path*
ISF 1.2
JSF Environment# J5F 1.2 with Facelets

MyFaces 1.1.4
Termplate* [ FALEIELSEISTIR -

(il [ < Back l Mext = H Finish H Cancel

Figure 2.1. Choosing JSF Environment

After specifying a proper JSF environment all the required libraries for the selected version will
be added to your project.

2.1. Facelets Support

In this section we will focus more on all concepts that are integrated for working with Facelets.

The Facelets extends JavaServer Faces by providing a lightweight framework that radically
simplifies the design of presentation pages for JSF. Facelets can be used in a variety of ways that
we will consider further in this section.
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2.1.1. Facelets templates

If you want to build an application using Facelets, just create a project with Facelets based on
version 1.2 of the JSF Reference Implementation, i. e. select the JSF 1.2 with Facelets in the
JSF Environment section of the New JSF Project wizard.

£ New |SF Project x

Create |SF Project @

The Create New Project Wizard is used for creating

a brand new project. If you already have a pre-existing
project, just use the Import Project Wizard to start working
with it in JBoss Tools.

Froject Name* []SFPrnjen:m-imFac elets ]

] Use default path*

l‘le!userh-mrkspac E.I']SFPI'Oj'EEtwiﬂ'IFaCE|EtEI

JSF Environment* JSF 1.1.02 - Reference Implementation
ISF 12

w*
Template ISF 1.2 with Facelets

MyFaces 1.1.4

@ [ < Back l[ Mext = ” Einish H Cancel

Figure 2.2. Choosing Facelets Environment

Once you've selected the environment, it's possible to specify the one of three available templates:




Facelets components

[E New |SF Project

Create |SF Project @

The Create New Project Wizard is used for creating

a brand new project. If you already have a pre-existing
project, just use the Import Project Wizard to start working
with it in JBoss Tools.

Praject Name* [ JSFProjectwithFacelets

] Use default path*

|\w:lrk5pai: e_jbTools/)|SFPojectwithFac elet's_

JSF Environiment® []SF 1.2 with Facelets

Ak

Termplate* FaceletsBlankWithoutLibs
FaceletsKickStartWithRILIbs
FaceletsKickStartWithoutLibs

7 Mext = ] [ Findsh l | Cancel

Figure 2.3. Choosing Facelets Template

The following table lists possible templates with Facelets for any JSF project and gives a proper

description for each one.

Table 2.1. Facelets Templates

Template Description

FaceletsBlankWithoutLibs

Some servers already provide jsf libs and you take risk of
getting conflicting libraries while deploying your project.
To avoid such conflicts, use a template without libs if you
have a server with its own jsf libraries

FaceletsKickStartWithRILibs

FaceletsKickStartWithoutLibs

A sample application with Facelets that is ready to run

A sample application without libraries

2.1.2. Facelets components

The JBoss Tools Palette [..[../jsf/html_single/index.html#palette] comes with the Facelets
components ready to use. A useful tip appears when you hover the mouse cursor over the tag,
the tip includes a detailed description of the tag component, the syntax and available attributes.



../../jsf/html_single/index.html#palette
../../jsf/html_single/index.html#palette
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e — "0 . °

B <!DOCTYPE html PUBLIC *-//W3C//DTD XHTML 1.© Transitional//EN® “http://www.w3.oi[= ® e @
<html xmlns="http://www.w3.0rg/1999/xhtm."” - — -
xmlns:ui="http://java. sun.com/jsf/Tacelets” 1= |Boss Ajaxdjsf
xmins:h="http://java.sun.com/jsf/html* = |Boss RichFaces
xmlns: F="http://java.sun.com/jsf/core” E]Eossszam
xmins:c="http://java.sun.com/jstl/core"> _EijF Core
<f:loadBundle basenames"resources™ var="msg” /> \= |SF Facelets 2
< component
<ui:composition template="/templates/common.xhtml"= > composition 3

The component tag and the compaosition tag behave
exactly the same, except the component tag will insert
a new UIComponent instance into the tree as the root
of all the child cemponentsfragments it has.

Syntax:
<ul:component=
</ui:component>

Attributes:

<ui:define name="pageTitle*=]5F 1.2 and Facelets under
=ui:define name="pageHeader"=]5F 1.2 Helle Application=|

<ui:define name="body~=>
<h:message showSummary="true" showDetail="false" st
<form jsfe="h:form" id="helloForm"=
msq. prompt
tfnpﬁtplaggll'Name' jsfe="h:inputText" required Ebncing
=input type="submit® jsfc="h:commandButton™ id="submit” “repeat
action="greeting" value="5ay Hello" /> H

el [ [»)

| ) _ _ ) x || = JSF HTML
VisualfSource Visual Source |Preview L= JSTL XML

Figure 2.4. Facelets Components

2.1.3. Code assist for Facelets

One more feature which comes with Facelets support is code assist (Ctrl + Space). It is available
for Facelets tags while editing .xhtml files.

e punamextini 5 =o
=f:LloadBundle basename="resources" Var=-||'|5g' />
<ul: Cﬁmoslt.\oﬂ termlate:' jtemlates/comﬂ LHKhtml® >

E:d =ui:define >Input User Name</ui.definex>
The literal name for this definition. This name will
«ui:define

match up with a tag in a target template

<ui:define
<h:mess)
<form j
#{m

=1in

<in

=/ form=|
=fui:defing|

|

Facelets Hello Application

B e R

Error Message

Fimsg.prompt] [# {person.name} Say Hello I
. g

Visual/Source Visual Source Preview

Figure 2.5. XHTML File Code Assist

What's more, code assist is also available for "jsfc" attribute in any HTML tag.




Code assist for Facelets

— - = I:I.'
W—_ e

ns:f="http://java.sun.com/jsf/cora"
ns:c="http://java.sun.com/jstl/core” >

[+)
I=

of: loadBundle basename="resources” var="msg" /> —
uiicomposition template="/templates/common.xhtmi®=
<ui:define name="pageTitle®>JSF 1.2 and Facelets under Tomcat. KickStart Applications
<ui:define name="pageHeader”=J5F 1.2 Hello Application</ui:define=

=uiidefine name="body" >
<h:message showSummary="true” showDetail="false" style="color: red; Tont-weight:
& =form jsfc="h:form® id="helloForm®=
${msg. prompt}
=input | />
(& dir

<INPUT | @ disabled
act

=/ Torms @ id il

:
</ul:define= -

ui:composition> |@ lang

= B

@ maxlength B
0 s e G
@ enblur ;
msou @ onchange
@ onclick
@ ondblclick o

Figure 2.6. Code Assist for JSFC Attribute

After selecting "jsfc" you get the code assist for JSF components available on a page.

~

@ nome xnimt_ i = | =

=!DOCTYPE html PUELIC *-//W3C//DTD XHTML 1.0 Tramsitional//EN" 'http:th.w.‘».orgfmthtmllm'l'l::

=html xmlns="http://www. w3, org/ 1999/ xhtml"
xmlns:ui="http://java. sun.com/jsf/Tacelets”
xmlns:h="http://java. sun.com/jsf/htmlL"
xmlns: f="http://java. sun.com/jsf/care”
xmlns:c="http://java. sun.com/jstl/core"=

<T:loadBundle basename="resources” vars"msg" />
<ui:composition template="/templates/common.xhtml®=>
<ui:define name="pageTitle®=]JS5F 1.2 and Facelets under Tomcat. KickStart Applicatic|_
<input jsfc=T= 0
Renders an HTML “input” element of “type” “text" & h:cornmandLink =
Decode Behavior @ h:dataTable
(Obtain the Map from the "requestParameterMap”™ property of the
ExternalContext. If the Map contains an entry for the “clientld” @ n:form
of the component, pass the value of the entry to the @ h:graphicimage i
setsubmittedvalue() method of the component, which must be
an instance of EditableValueHolder.
Encode Behavior @ h:inputSecret
Render the clientld of the component as the value of the =
"name” attribute. Render the current value of the component as : =
the value of the *value® attribute. If the “styleClass® attribute is |® h:inputTextarea
specified, render its value as the value of the “"class” attribute.

@ h:inputHidden

(4]

@ h:message

h:messages
) g x

@ h:outputFormat

4]

Figure 2.7. Code Assist for JSF Components

When a component is chosen you will see all available attributes for it.
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iz hame xhtml E ﬁmnm ﬁ \i B0 web.xml | =0

<I'DOCTYPE html PUBLIC *-//W3C//DTD XHTML 1.0 Transitional// EN" 'nttp:f{hw.wi.orngfontmL].fD‘l'L:'T_
. <html xmlns="http:// /www.w3. org/1999/xhtml"
xmlns:ui="http://java. sun.com/)sfT/Tacelets”
xmlns: h="http://java. sun.com/jsf/htmL"
xmlns: f="http://java. sun.com/jsf/core”
xmlns:c="http://java. sun.com/jstl/core">

<f:loadBundle basename="resources” wvar="msg" /=
=ul:composition template="/templates/common. xhtml®=
“ui:define name="pageTitle"=JSF 1.2 and Facelets under Tomcat. KickStart Applicatic

] <input jsfc="h:inputText* }=> ]
If the value of this attribute is “off”, render "off” as the value of |@ accept
the attribute. This indicates that the browser should disable its
autocomplete feature for this cormponent. This is useful for @ accesskey
components that perform autocempletion and do not want the | @ align
browser interfering. If this attribute is not set or the value is "on®
render nothing. @ att

0 autocomplete

@ binding
@ checked

@ class
@ converter

@ converterMessage b

1]

Figure 2.8. Available Attributes for the Component

2.1.4. Open On feature

Finally, Eclipse's OpenOn feature for editing Facelets files is supported. Using this feature, you
can easily navigate between the Facelets templates and other parts of your projects. Just by
holding down the Control key while hovering the mouse cursor over a reference to a template, the
reference becomes a hyperlink to open that template.

=0
<!DOCTYPE htmL PUBLIC "-//W3C//DTD XHTML 1.8 Transitional//EN® “http://we.w3. of=)
<html xmlns="http://www.w3.org/ 1999/ xhtml"”
xmlns:ui="http://java. sun.com/jsf/Tacelets"
*mins:h="nttp://java.sun,com/jsf/html”
xmlns: f="http://java.sun.com/jsf/core” =

=f: loadBundle basename="resources” var="msg" /=

=<ui:composition template="/templates/common.xhtml® =

<ul:define nam:'pageTltle':Input User Name</ul:define>
=ui:define name="pageHeader”>Facelets Hello Application</ul:defTinez|-

<ui:define name="body">
<h:message showSummary="true” showDetall="false” style="coler:
=form jsfc="h:form" id="helloForm"=
#{msg. prompr}
=input jsfc="h:inputText® required="true® id="name* value=*
=input type="submit® jsfc="h:commandButton" id="submit"”
action="greeting” value="5ay Hello" />
</ form=
<fuli:define=
E </ui:composition=>
</html=>

(T

L (4] I D

VisualfSource Visual Source | Freview

Figure 2.9. Template Hyperlink
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Projects

To take an advantage of JSF firstly you should perform one of the next steps:

» Create new JSF projects

Import (open) existing JSF projects

Add JSF capability to any existing Eclipse project

In this section we're going to stop on each of them in detail.

3.1. Creating a New JSF Project

Import and add JSF capability to any existing project created outside Eclipse.

If you want your project to already contain all JSF libraries, tag libraries and JSF configuration
file, just organize a new brand JSF project. It is possible to do this easily with the help of the
special wizard. To get it, select File > New > Project > JBoos Tools Web > JSF > JSF Project

and click Next.

4 New Project x

Select a wizard

Create a JSF Project

Bl
&

Wizards:

[t-_.rpe filter text ]
P FIDETTTae

P = |2EE

I & Java

I* (= |Boss jBPM

= |2 |Boss Tools Web

[¥]

v = |SF

Y
P (= Struts
I & PA =

(i) Mext = I Cancel
eSS

Figure 3.1. Choosing a JSF Project
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On the next form you'll be prompted to enter Project Name and select a location for the project
or just leave a default path.

Here, JSF Version also allows you to select which JSF implementation to use.

£ New |SF Project ®

Create |SF Project @

Thee Create Mew Project Wizard is used for creating

a brand new project. If you already have a pre-existing
project, just use the Import Project Wizard to start working
with it in JBoss Tools.

Froject Name* [ JSFFProject ]

7] Use default path*
ISF 1.2
JSF Environment® JSF 1.2 with Facelets

MyFaces 1.1.4
Ternplate* [ P ENELSBIETIR ol

@ [ < Back l Mext > ” Finish H Cancel |

Figure 3.2. Creating a New JSF Project

There is a number of predefined project templates that are flexible and easily customizable. Thus
you can pick a different template on which the projects Importing Existing should be based on.
Almost all templates come in two variations: with jsf libraries and without ones.




Creating a New JSF Project

New |S5F Project

Create |SF Project @

The Create New Project Wizard is used for creating

a brand new project. If you already have a pre-existing
project, just use the Import Project Wizard to start working
with it in JBoss Tools.

Praject Name* [ JSFProject

7] Use default path*

lmomeiuserhwrk;pai: e/|SFProject

ISF Environment® [ IEC 71 7 AT Oafaeanes liovsmbaess sk b - ]
JSFBlank

Termplate* JSFBlankWithLibs
JSFKickStart
JSFEickStartWithLibs
|SFEIckStartwithoutLibs

(il [ < Back l Mext = ” Finish H Cancel

Figure 3.3. Choosing JSF Templates

The table below provides description for each possible JSF template.

Table 3.1. JSF Project Templates

Template Description

JSFBlankWithLibs This template will create a standard Web project structure with all JISF
capabilities

JSFKickStartWithLibs  This template will create a standard Web project structure but will also
include a sample application that is ready to run

JSFKickStartWithoutLib&ome servers already provide jsf libs and you take risk of getting
conflicting libraries while deploying your project. To avoid such conflicts,
use a template without libs if you have a server with its own jsf libraries

On the next screen select what Servlet version to use and whether to register this application
with JBoss AS (or other server) for running and testing your application.

The Context Path is the name under which the application will be deployed.

The Runtime value tells Eclipse where to find Web libraries in order to build (compile) the project.
It is not possible to finish project creation without selecting Runtime. If you don't have any values,
select New... to add new Runtime.

11
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The Target Server allows you specifying whether to deploy the application. The Target Server
corresponds to the Runtime value selected above. If you don't want to deploy the application,
uncheck this value.

¢ New |SF Project ®
Web

Serviet Version [2.4

Context Path* | JSFProject

| e

Runtime:* []Enss 4.2 Runtime = Mew

B [/] |Boss Application Server 4.2 Mew...

Deselect All

| Cancel

Figure 3.4. Registering the Project on Server

When you are all done, you should have the project that has been appeared in the Package
Explorer view:

12



Importing Existing JSF Projects with Any Structure

[f Package E 2 . K web Froject © O

-

= & |SFProject
(™ JavaSource
I =4 Web App Libraries
P+ B4 JRE System Library [jdk1.5.0_12]
b= ant
= = WebContent
b (= META-INF
= = WEB-INF
= lib
|¥] faces-config.xmil

=t web . xml

Figure 3.5. A New Project in the Package Explorer

At this point you can open faces-config.xml and start working on your application. There are a
lot of features to develop JSF applications. We will describe the features further.

3.2. Importing Existing JSF Projects with Any Structure

For detailed information on migration of JSF projects into a workspace see Migration Guide [../../
Exadel-migration/html_single/index.html#jsf_struts].

3.3. Adding JSF Capability to Any Existing Eclipse
Project

It's also possible to add JSF capability (JSF libraries, tag libraries) to any existing Eclipse projectin
your workspace. After that you'll be able to make use of such editors as JSF configuration editor,
JBoss Tools JSP editor and any others.

Right click the project and select JBoss Tools > Add JSF Capabilities. This will start the process
of adding all necessary libraries, files to make this a Web JSF project.

13
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MR B oo roecs| = O

B & .
b &Sk
= M *
r e SomeWebPraject =
Go |nto
Open in New Window
Open Type Hierarchy Fd4
Show In Shift+Alt+W  »
12 Copy Ctri+C
7 Paste Chri+V
K Dalete Delete
Build Fath ¥
Source Shift+Alt+5  *
Refactor Shift4+AIL+T *
) T 23 Import..
3 Expaort. ..
7 Refresh FS
Close Project

Close Unrelated Projects
Assign Working Sets...

Run As ¥
Debug As »
Profile As J
Validate

5. Add Struts Capabilities. .
k

Team E& Add |SF Capabilities...
Compare With 4 -

Restore from Local History...

|Boss Tools k

PDE Tools r
|awva EE r
Properties Alt+Enter

Figure 3.6. Adding JSF Capabilities

The wizard will first ask you to show the web.xml file location and the project name.

14



Adding JSF Capability to Any Existing Eclipse Project

[ Import J5F Project x|
Project Location
Please select web_ xml location Q

| SomeWebProject |

web . xmil Location® lmnamefuﬁer.fworkspar:eISumeWebProjecWebCantenmﬂﬂEB-tNF.fweh.:-trnl Change.., |

@ Mext = Einish ] | Cancel

Figure 3.7. Project Location

On the last form you can set the different folders for your project as well as register this application
with a servlet container.

Make sure to select Add Libraries to add all required JSF related libraries to this project.
The Context Path is the name under which the application will be deployed.

The Runtime value tells Eclipse where to find Web libraries in order to build (compile) the project.
It is not possible to finish project import without selecting Runtime. If you don't have any values,
select New... to add new Runtime.

The Target Server allows you to specify whether to deploy the application. The Target Server
corresponds to the Runtime value selected above. If you don't want to deploy the application,
uncheck this value.

15
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4 Import |SF Project X

Project Folders
Select Project Folders Q
Web Root:-* [ﬂmme}user}wndcspaceﬁmneWeh‘Pru]ect.lWehCumem ” Change... ]
Source Folder | Mmomejuser/workspace/SomeWebProject/src || change... |
Classes Folder [mnmem:ermomspaceﬁmewgbﬁnqetuhuld{classes ” Change... ]
Lib Folder | mome/user/workspace/SomeWebProject/\WebContent/WEB-INF/iib || cnange... |
[7] Add Libraries
Environment [jEF 1.1.02 - Reference Implamentation - ]
Serviet Version: 2.5 |~ |

Context Path* | SomeWebProject |

Runtime -+ |Boss 4.2 Runtime v || New. |
fRlasEE e JBoss Application Server 4.2 | New.

| Deselect All
(il I < Back ]| Mext = i I Einish I [ Cancel I

Figure 3.8. Project Folders

Once your project is imported you can see that JSF related libraries have been added to your
project: jsf-apijar and jsf-impl.jar .

You are now ready to work with JSF by creating a new JSF configuration file:

16



Adding Your Own Project Templates

i Package E i3 E.jWeb Project| = O

b & |SFProject

b i® JavaSource
I+ = Web App Libr
I+ = JRE System L

= = ant

& build_xmil
= = WebContent
P = META-INF
b = pages
P Elib
w7 struts-b
|| struts-c
7 struts-h
s struks-lg
[¥] walidatii
[¥] validatg
izt web.xn

g index jsp

= Lk, i
L 5

Go Into

Open in New Window
Show In

- Copy

B8 build props

i

|z Paste
o Delete

Build Path
Refactor

£23 [mport...

&3 Export...

4" Refresh
Assign Working Sets._..

Validate

RLf AS

Debug As

Profile As

Team

Compgre With

Restore from Local History. ..
Source

Properties

< 22 somewebprojec s R : )5F Project

| struts Project
[ Project...

Shift+Alt+W * & Package

& Class

& Interface

&5 Source Folder
[T Folder

7 File

EM struts Config

k I_',-'!' Faces Config

Ctri+C

Ctri+v
Delete

Shift+AlL+T * > Tiles File

4 validation File

2 |SP File
H% XHTML File

F5 % HTML File
£% £S5 File
N IS File
7% Properties File

v [ Example...

[
[ Other...
¥

Alt+Enter

Figure 3.9. Creating a New JSF Configuration File

Once the file has been created, it should be opened in a special Faces Config Editor.

3.4. Adding Your Own Project Templates

Template is a set of files that is served as a basis to facilitate the creation of a new project. Project

templates provide content and structure for a project.

There is a powerful templating capability for creating new and importing existing Struts and JSF
projects. This templating facility has a variety of aspects to consider. But, let's start with the most
straightforward case and consider the process of creating a template from your existing JSF

project.

Let's say you have a project that you want to use as the basis for a new template. Follow these
steps to make a template out of it:
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Chapter 3. Projects

» In the Web Projects view, right-click the project and select JBoss Tools JSF > Save As
Template

|2 PackageE ,E;‘m Project 33 = E.
2EHEE B

JBoss Tools JSF Save As Template. ..

b |5 somewebF
X Delete Femove |SF Capabilities

Froperties... 5 verify
Add Custormn Capabilities. .

Figure 3.10. Saving Your Project as Template

« In the first dialog box, you can choose a hame for the template (defaults to the project name)
and confirm what run-time implementation of the project technology will be used

£ Add |SF Project Template x
Define Commeon Template Propertles @
Name:* |l'-'ler5FPrujer:t |
Implementation:* [jSF 1.1.02 - Reference Implementation - |

[ Next>> | | Finiish | | cancel
J

Figure 3.11. Define Template Properties

« Select Next and you will be sent to a dialog box with your project structure displayed with
check boxes. Here you can check only those parts and files in your project directory that should
be part of the template

18



Adding Your Own Project Templates

& Add|SF ProjectTemplate = X

Select Folders and Flles @

+ [ & |5FProject
[J (= settings
= JavaSource
= [ (= WebContent
] = META-INF
= [ (= WEB-INF
L) (= classes
O & lib
El & ant

| <« Back || Next == | Finish || Cancel

Figure 3.12. Define Template Properties

« At this point, unless you want to designate some extra files as having Velocity template coding

inside them, you should click Finish .

That's it. Now, you can use this template with any new or imported project that uses the same

run-time implementation as the project you turned into a template.

At this point, you have a fully configured project and now you can bring some new logic to it starting

from JSF configuration file.
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Chapter 4.

JSF Configuration File Editor

First, we should mention that JSF configuration file ( faces-config.xml ) is intended for registering
JSF application resources such as Converters, Validators, Managed Beans and page-to-page
navigation rules.

Now, let's look at how you can easily configure this file by means of a special graphical editor for
JSF configuration file. The editor has three main views:

» Diagram
e Tree
e Source

They can be selected via the tabs at the bottom of the editor.

4.1. Diagram view

Here, we will show you how to work with JSF configuration file through the Diagram view of the
editor.

As you can see on the figure below, the Diagram view displays the navigation rules in the faces-
config.xmil:

21



Chapter 4. JSF Configuration ...

- faces-config.xmil =0

I}

fchooselocale.|sp
[storeFront.|sp
storeFront
‘ e | &
‘ carDeatail

lcarDetail.jsp

m A feontirmChoices.jsp
confirmChoices —

Customerinfo
carDetail

B 3E

[Customerinfe.jsp

1] Minish.jsp
finizh m‘

Diagram | Tree Source

Figure 4.1. Diagram View

If your diagram is large, make use of the Outline view. Within it you can switch to a Diagram
Navigator mode by selecting the middle icon at the top of the view window. It allows you to easily
move around the diagram. Just move the blue area in any direction, and the diagram on the left
will also move:

*faces-config.xmi 53 = B & outine 2 ¥ |Boss Tools Falette =8

JehooseLocale.isp | 5 =8

:
L “ storeFrant B &
B

IstoreFront.jsp

- 2, JjearDetail.jsp
carbetall -}:’—lj-

confirmChaice

Bl

Diagram | Tree | Source

Figure 4.2. Outline View for Diagram

To create a new page here, you should click the page icon (View Template) on the toolbar from
the left and then click anywhere on the diagram. A New Page Wizard will appear.

To create a transition for connecting pages:

» Select the transition icon from the toolbar (New Connection).

22



Diagram view

 Click the source page.
 Click the target page.

A transition will appear between the two pages:

M races-config.sxml 22

fehooselocale.|sp

1K IstoreFront.jsp

Frant
store 1y m T
carDetail

Figure 4.3. Transition between JSP Pages

Lidleiiie

It is also possible to create a new page with context menu by right-clicking anywhere on the
diagram and selecting New View.

M faces-config.xmil &2 =5

1

r
b -

fchooselocale.jsp

IstoreFront.jsp
storéFront
‘ i)
S
fcarDetail.jsp

i2H feonfirmChoices.jsp
confirmChoices =
= I Customerinfo

I carDetail

L+

Auta Layout Minish.jsp

Select Elerment finish
W Verify

Input Methods v

Diagram | Tree  Source

Figure 4.4. Creating a New View

To edit an existing transition, first select the transition line. Then, place the mouse cursor over the

last black dot (on the target page). The mouse cursor will change to a big +. At this point, drag
the line to a new target page:
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M. faces-config.xmil &3

L

..; lcarDetail.jsp
X [@E

-; IstoreFront.jsp

carDetail
T fchooseLocale.jsp

] >

Figure 4.5. Editing Transition between Views

4.2. Tree View

You can find it more convenient to edit your JSF Configuration file in the Tree view of the VPE.

The view displays all JSF application artifacts referenced in the configuration file in a tree format.
By selecting any node on the left, you can see and edit its properties which will appear in the right-
hand area. Let's look at the structure of this tree more closely.

e Under the Application node you can adjust JSF application specific settings such as
internationalization, possibility to set extensions, add property and variable resolvers, etc.
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Tree View

Faces Config Editor

= faces-config

= A faces-config.xmibe

<% Application

5 Components
LB Converters

b 5@ Managed Beans

b g Mavigation Rules
@ Referenced Beans
i Render Kits
i walidators
' Extensions

v Application

¢ EL Resolvers

» Property Resolvers
» Variable Resolvers
* Message Bundles
¢ Resource Bundles

= Locale Config

Default-Locale: | en

Supported Locale
Locale

ottt

¥ Extensions

« Advanced

D

Diagram Tree | Source

Figure 4.6. JSF Application Specific Settings

« The Components node is for registering custom JSF components. Right-click and choose New
> Component or just press the Add button in the right-hand area to add a new component

to the JSF Configuration file.
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Faces Config Editor

= faces-config - Components

- A faces-config.rnl type e Add...

2 Application

B Componants : i
9 Compaonent...

B Converters

|
|
b & Managed Beans RFF |
b G Mavigation Rules |

3 peferenced Beans

4 Render Kits
& walidators )
Properties
& Extensions
7 Verify

Diagram Tree | Source

Figure 4.7. Registering a New JSF Component

In the Add Component wizard you should set a component type and point to a component class
by using the Browse button or create a new class for this component by using the Component-
Class link.
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Tree View

Add Component

Component

Attribute Component-Type must be set. @
Component-Type* I ]
Component-Class* [ | [ Browse... ]

)] f | | Cancel

Figure 4.8. Adding a New JSF Component to the JSF Configuration File

« Use the Render Kit node to create and register a set of related renderers for custom JSF
components.
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— .

Faces Config Editor

= faces-config - Render Kits
- |# faces-config.rnl id Elnn Add...
@ Application

 Components

|
@ Converters Bt
b & Managed Beans |
b Gg Mavigation Rules |

3 peferenced Beans

& walidators

& Extensions

Properties

Diagrarm Tree | Source

Figure 4.9. Adding a New JSF Component to the JSF Configuration File

» Underthe Converters node you can create a converter class for your JSF application either with
id or for a proper class. How to do that see the Create and Register a Custom Converter section.
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Tree View

| —

Faces Config Editor

~ faces-config ~ Converters

= A Faces-config xXmi d - IM—GI
& Application
5 Companents

&, Converters ;
:
I & Managed Bea
b LE: Navigation Ru t tr
& Referenced B
7 Render Kits
& wvalidators

Properties...

| Veriry

[+] I [»]

Diagram Tree | Source

Figure 4.10. Creating a New Custom Converter

« The Managed Bean node is meant for creating and registering Bean classes in your JSF

application. Read more on the topic in the Managed Beans chapter.
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0
0

% faces-conigami &3

Faces Config Editor

~ faces-config ~ Managed Beans

= A faces-config.xmi name class scope

2 Application

% Companents
¥ Converters

- & Managed Beans

bt
b @ Nay o cut Crl 4+ X

k& Ref [ Copy Ctrl + C
&y Ren [ Paste Ctrl + W
= vali

¥ Delete Delete

Properties ..
v Verify

a i )

Diagram Tree | Source

Figure 4.11. Managed Beans

« Usethe Navigation Rules node to configure a navigation between the pages in your application:
create a new navigation rule and adjust necessary properties for it in the right-hand area.

Tip:
\

The same you can do in the Diagram view of the JSF Configuration file editor.

30



Tree View

0
0

Faces Config Editor
= faces-config

= A faces-config.xml
@) Application
54 Components
&h converters
P & Managed Beans
= L Navigation Rules

= T3 jpagesfinputiUserial

-+ hello
5% Referenced Beans
(54 Render Kits
= validators
= Extensions

[<] I | [2)

- Mavigation Rule

- -ID: | /pagesfinputUserMame jsp H Browse... ]

Description:

(<] 1ii

+* Navigation Cases
From-Outcome From-Action To-View-ID Redir Add...

B
halle: ipagesihells jzp o

- Advanced

ID:

small-lcon:

|
Display-Mame: |
|
|

Largr_hlcnn:

Diagrarm Tree | Source |

Figure 4.12. Configuring Navigation Rules

» Underthe Referenced Beans node you can add a new Referenced Bean and configure various
properties for it. To learn more on this refer to the Create and Register Referenced Beans

section.
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i -

Faces Config Editor

= faces-config ~ Referenced Beans

v 8 faces-config.xml name class Add...
&) Application |
5 Compaonents {
5 Converters |

[ & Managed Beans |
b G Mavigation Rules
= Referanced Beaan... .
i Render Kits i
i validators
i Extensions

Properties

7 Verify

[<] | I [2)

Diagram Tree | Source

Figure 4.13. Referenced Beans

» The Validators node is needed to create validator classes for organizing the validation of your
application data. You can read more on the topic in the Create and Register a Custom Validator
section.
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Tree View

i

Faces Config Editor

= faces-config = Validators
- W faces-config.xml id e
@ Application

% Components
E# converters
b 5@ Managed Beans

b L& Mavigation Rules
& Referenced Beans
7 pender Kits

¢ validators

& Extensions

*| & vahidator... |

Properties
al i [ B

Diagrarm |'|'rea| EnurcaJ

Figure 4.14. Validators

* The Extensions node is for setting extensions for your faces-config.xml.
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= faces-config

Faces Config Editor

- W faces-config xml
2 Application
5 Components
B Comverters

-~ Extensions

element

b 5@ Managed Beans

b E& Mavigation Rules
% Referenced Beans
7 pender Kits
& walidators

O Extensions 7
Extension

[<] |

| Properties

Diagrarm Tree | Source

Figure 4.15. Adding Extensions

In the Tree view you can also edit the properties of the selected element with the help of the
Properties view as shown below:

| *faces-config xmi E-'.!\

= faces-config

~ [ faces-config xmi*
@ Application
55 Components
5 Converters
= I Managed Bean:
@ name
I+ L Navigation Rule
5 Referenced Be
5 Render Kits
i Validators

P

Faces Config Editor

= Managed Bean

Managed-Bean-Name: |per50r‘|

Managed-Bean-Class: |demo-Herson || Browse... I

Managed-Bean-Scope: |[requesl | v ]l

Description: B
=
-]

] Il 0]
~ Properties
name class value

name:

Remove...

| Properties 52 @~ =0
Property Value

Diagram heJ Snl.n:e|

Comiment
description
display-name
id

large-icon

¥
[N ENELEL REET B ELE demo . Person

L

managed-bean-name  person
managed-bean-scope request

small-ican

[T+

Figure 4.16. Properties View
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Source View

4.3. Source View

Here, we'll discuss how you can configure your faces-config.xml with the help of Source View.

The Source view for the editor displays a text content of the JSF configuration file. It is always
synchronized with other two views, so any changes made in one of the views will immediately
appear in the other:

% *faces-configxmil 2 =8

<managed-bean=> =
<description=
Causes the default VariableResclver implementation to instantiate
the managed bean, CustomerBean of the class, carstore.CustomerBean
in session scope if the bean does mnot already exist in any scope.
=fdescription=
<managed-bean-name> customer =/managed-Dean -namas
<managed-bean-class> carstore. CustomerBean </managed-bean-classs>
<managed-bean- scope> session </managed-bean- scope>
</managed-bean>

=managed-bean>
<description>
The main backimg Tile mean
=fdescription=
<managed-bean-name> carstore </managed-bean-name>
<managed-b&an-classs carstore.CarStore </managed-bean-class>
=managed-bean- scope> session =/managed-bean-scope=
</managed- bean >

'\’-I'IdUJ.qd'L.'I.U[I- rule= 1
<from-view-id>/chooselocale. jsp</from-view-id>
-.'hi-l\c'_“l(_]ﬁf.‘l[}l‘l-t:dst-?} —{

<description=
Any action on chooselocale should cause navigation to storeFront.jsp
=/description=
=f rom- outcome=storeFront=</from- outcome>
<to-view-id>/storeFront. jsp</to-view-id>
</navigation-case>
] ] [+

Diagram | Tree Source

(4]

Figure 4.17. Source View

You can also work in the Source view with the help of the Outline view. The Outline view shows
a tree structure of the JSF configuration file. Simply select any element in the Outline view, and
it will jump to the same place in the Source editor, so you can navigate through the source code
with Outline view.

. *races-config.xmi B y = B | 2 outine = =8

<navigation- rule> = E" -

<from-view-id=/chooselocale. jsp</from-view- id=

§ & Companents

<description> b G Converters
Any action on chooselocale should cause navigation to storeFront.jsp
</descr - + @ Managed Beans
<from-ol e>storefFront</from-outcomes b @ nNa
<to-view-id>/storeFront. jsp</to-view-id>
] </navigation-case> P @sa
</navigation- rule> b @ gera
<navigation- rules > @fran
<From- view- id=/storeFront. jsp</from- view- id> @ customer
<navigation-case> @ carstore
<description>
Any action that returns "carDetail® on storeFront.jsp should = (G Navigation Rules
cause navigation to carDetail.jsp < @ JchooseLocale jsp
</description> k

<f rom-ou tcome>carbetail</T rom- outcomes B storefront

<to-view-id=/carDetail.jsp</to-view- id= H = % JstoreFront jsp
</navigation-case>
</navigation- rule> > carDetail
— = @ JcarDetail jsp
<navigation- rule> -
[ | ID = confirmCheices |
Diagram Tree Source @l - ']‘_‘

Figure 4.18. Outline View
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4.4. Editor Features

Here we'll discuss a very important features that JSF configuration file editor provides for work
with JSF resources.

4.4.1. Open On

The JSF configuration file editor comes with a very useful OpenOn navigating feature.
More fully you can read about it in our Visual Web Tools Guide [../../isf/html_single/
index.html#OpenOnSelection4Hyperlinknavigation].

4.4.2. Code Assist

Code Assist provides pop-up tip to help you complete your code statements. It allows you to write
your code faster and with more accuracy.

Code assist is always available in the Source mode:

I *faces-config.xmi 2

e e

<man aged- bean- scope> application </managed-bean-scope>

<managed- property>
<descriptions
Initializes the shape property of the managed bean, gerA with the value
poly.
<fdescription>

Element : description
[The "description” element contains a textual description of the

€ display-name element it is nested in, optionally flagged with a language code
<3 lcon using the "xml:lang” attribute,
<> list-entries

< map-entries

< null-value

< property-class
< property-narme
<» value

# comment - xml comment 4

# ¥S)| nroceccing inctruction - XS1 amesgoing inctniction
<property-name>coords</property-name> I_I
i

<value> =
(T I IC
Diagram Tree Source

Figure 4.19. Code Assist in Source View

4.4.3. Error Reporting

When you are developing your project, error checking is constantly provided. This greatly reduces
your development time as it allows you to catch many of the errors during development.

Errors will be reported by verification facility:
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../../jsf/html_single/index.html#OpenOnSelection4Hyperlinknavigation
../../jsf/html_single/index.html#OpenOnSelection4Hyperlinknavigation

Error Reporting

<managed-bean-name=>carstore</managed- bean - name=
E <managed-bean-class>carstore, Carstore-0ld</managed-bean-class>
<managed-bean- scope>session</managed- bean- scope>
=/managed- bean>
<navigation-rule=>
<from-view-id=/chooselocale. ] sp</Trom-view- id=
=navigation-case=
<description=Any action on chooselLocale should cause navigation to storef
al ] | [+
Diagram Tree Source

| [ Problems 53' Tasks Servers
1 error, 9 wamnings, 0 infos
Description Resource Path Location

= ' Errors (1 ltem)
@ error: Attribute managed-bean-c faces-config. cardemo/WebContent/WE line 176

Figure 4.20. Error Reporting in Source View
Other errors are also reported.

<managed-bean-name>

i <sometag
£3 </managed-bean-name=

<nawvigation- rule>
<from-view-id=/chooselocale. jsp</from-view- id>
=navigation-case=

[:] [ Ir]

Diagram | Tree Source

[£ Problems 52 Tasks Servers
2 errors, 9 warmnings, 0 infos
Description Resource Path Location

= ' Errors (2 items)
9 181:12 Element type "sometag” | faces-config. cardemo/MWebContent/WE line 181
@ 182:4 The element type "someta faces-config. cardemo/MWebContent/WE line 182

Figure 4.21. Other Errors Reporting
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Managed Beans

There is lots of power to work with managed beans.

» Add and generate code for new managed beans
« Generate code for attributes and getter/setter methods
» Add existing managed beans to JSF configuration file

Thus, in this section we will guides you through all this possibilities.

5.1. Code Generation for Managed Beans

To start, create a new managed bean in JSF configuration file editor, in the Tree view.

Faces Config Editor

= faces-config = Managed Beans

= A faces-config.xml — J— scope | Add
2 Application
% Components

ﬂ Converters

Mana ge d Bean

aNI
@ s of Cut Cirl + X
G Navi [E Copy Ctrl + C
@R&f Faste Ctrl + W
“
71 Rene K Delete Delete
= Valig Properties..
I_|: il 1 9 Verify

Diagram |'rl'ee] Snl.rce[

Figure 5.1. Creation of New Managed Bean
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[ New Managed Bean ®»
Managed Bean @
Scope Irequest [ S ‘
Class* [example.carﬁean ] [ Browse... l

Name#* [carBean |

[¥] Generate Source Code

[ Finish ” Cancel

Figure 5.2. New Managed Bean

After the "Java" class has been generated you can open it for additional editing. There are two
ways to open the "Java" class:

» click on Managed-Bean-Class link in the editor

or

« right click the managed bean and select Open Source

— = =

Faces Config Editor

[+

- faces-config ~ Managed Bean

= (B faces-config.xmi — Managed-Bean-Name: |carBean |

@ Application

5 Components
¥ Converters

|example.carﬂean ‘ [ Browse... ]

[request wF ] =

= [ Managed Bean Description: E
& NA = =
& SA

= Properties ]

“ carBean

(& Navigation Rule name class value Add..,

Eﬁ Referencedge | | | —
7 Render Kits :

& walldators B
[+] I T+

(4]

Diagram Tree | Source

Figure 5.3. Opening of Created Managed Bean
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Code Generation for Managed Beans

The generated Java source should look as follows:

| faces-config.xmi

:-.-.- ﬁ?_f * +{—|
. package example;

_.I'r"

* gauthor root

*

*

public class carBean
-{ public carBean() {

}.

(el

Figure 5.4. Java Source Code

You can also generate source code for properties, also includes "getter" and "setter" methods.
Right click on the bean and select New > Property . You will see Add Property dialog.
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G, 1 cooe0 v

Faces Config Editor

I+

- faces-config ~ Managed Bean
= A faces-config.xml |- Managed-Bean-Name |carBean |
2 Application
~ e Managed-8ean-Class. [example cargean | [ prowse... |
55 Companents
¥ converters Managed-Bean-Scope: [request st ] =
+ @& Managed Bean Description: E
& NA = -
. | i [¥]

« Properties

= carBean

Open Declaration List-Entries |
Map-Entries

Rename Class...

m:ag‘cu cirl 4+ X
{@®c Ctrl + C
Diagra 'Y _

(]

K Dalate Delete

Properties._..

2 Verify

Figure 5.5. Generation of Source Code for Properties

When the form is open make sure that all the check boxes are selected:

» Add Java property
¢ Generate Getter

¢ Generate Setter
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Add Existing Java Beans to a JSF Configuration File

¢ Add Property x
Property @
Property-Name:* |carName [+ ]
Property-Class:  |javalang.String || prowse.. |
Value Kind :'u'alue |;|
Value: . || cnange.. |
%
=
W
| Finish | | Cancel

Figure 5.6. "Add Property" Form

Once the generation is complete, you can open the file and see the added property with "get"
and “"set" methods:

| *faces-configxml  [J] carBean java £ =0
i

I" -

package example;

— l'.l L
¥ gauthor user
'
'
public class carBean {
private java.Lang.String carName;

public carBean() {
}

public java.Lang.String getCarMame() {
return cariames;

}

public void setCarName(java.Llang.String carName) {
this.carlName = carName;
}
¥

Gl D]

Figure 5.7. Generated Java Source Code for Property

Thus, we've discussed everything which comes to creating a new Managed Bean. The next
section will show you how to add an existing Bean into a JSF configuration file.

5.2. Add Existing Java Beans to a JSF Configuration
File

If you already have a Java bean you can easily add it to a JSF configuration file.
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You should start the same way you create a new managed bean. Use the Browse... button to
add your existing Java class.

C MNew Managed Bean x

Managed Bean @

Scope | request | = I

Clags* [emmple.camean | Browsa. . |

Name* | carBean |

/] Generate Source Code

| Finish I| Cancel

Figure 5.8. New Managed Bean Form

Once the class is set, its Name will be set as well. But you can easily substitute it for the other one.
Notice that Generate Source Code option is not available as the "Java" class already exists.

After adding your class Next button will be activated. Pressing it you'll get Managed Properties
dialog where all corresponding properties are displayed. Check the necessary ones to add them
into your JSF Configuration File.
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£ New Managed Bean

Managed Properties

Select properties you want to add to the managed-bean

@

!
name value

=< Back ] I Finish

I | Cancal

Figure 5.9. Selection of Bean's Properties.

If you don't want to add any, just click Finish.

Above-listed steps have demonstrated how you can specify an existing Bean in the JSF
configuration file, i.e. faces-config.xml. In the next chapter you'll know how to organize and

register another kind of artifacts.
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Creation and Registration

6.1. Create and Register a Custom Converter

It's also possible to create a custom Converter in order to specify your own converting rules. Let's
look at how you can do this.

To create and register a custom converter it's necessary to go through the following steps:

* In the Project Explorer view open faces-config.xml and select Tree tab.

P faces-config.sxmi 2 =8

Faces Config Editor

~ faces-config ~ Converters
= A faces-config xml id class Add. .. J
2 Application

= Components

&, Converters

I Managed Beans
kg Navigation Rules
& Referenced Beans
= Render Kits

& Validators

Diagram Tree Source

Figure 6.1. Converters

* Select Converters and click on Add button.

« On the form type the name of your converter in the Converter-id field and name of the class for
converters. After clicking Finish button your custom converter is registered under the entered
name.
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£ Add Converter =

Converter 0
Converter-id:* [MyConverter |
Converter-Class:* [l:est Customcaonverter ] l Browse. I
(i) | Finish | [ Cancel I

Figure 6.2. Add Converter Form

* Now you can create "converter" class. Inthe Converter section you should see your Converter-
id and Converter-class. Click on Converter-class to generate the source code.

3 Components
< G Converters ¢ Converter-Class. |test.cus|:omanverter |[ Browse

W MyConverter Description H

& Managed Beans |

= ) =0
Faces Config Editor
~ faces-config - Converter A
= |# faces-config xmi* Canventar-id: |MyCunverter |
@ Application | H — ]
Converter-for-Class:

i Navigation Rules

- Attributes
3 Referenced Beans

[ Render Kits name class ( Add... ]

& Validators

~ Properties

Diagram Tree|Source]

Figure 6.3. Generation of Source Code for Converter Class

« A usual wizard for creating a Java class will appear. All needed fields here will be adjusted
automatically. Just leave everything without changes and click Finish.
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4 New Java Class x

java Class
Create a new Java class. @

Source folder: [JSFPrujchjavaSuun:E ][ Browse... I

Package: [test ] Browse.. .

[] Enclosing type:

Mame: [Cusﬂ}mconverter
Madifiers: 3 public () default
[] abstract [] final
Superclass: [jaua.lang.ﬂbject ] [ Browseg... I
Interfaces: Add...

Which method 51.1.|b5. would you like to
[] public static void main(String[] args)
Constructors from superclass
Inherited absiract methods
Do you want to add comments as configured in the properties of the current project?
[ Generate comments

(id] [ Einlsh H Cancel l

Figure 6.4. New Java Class Form

» To open a converter class click again on Converter-class link in the Converter section.

49



Chapter 6. Creation and Regis...

™ races-configxmi | [I] CustomConverterjava &3 =0
package test; :_
import org.apache.commons.beanutils. Converter;
public class CustomConverter implements Converter
{
o public CustomConverter()
{
super ();
Z SATODOD Auto-generated constructer stub
i }
public Object convert{Class argd, Object argl)
{
| S/TODD Auto-generated method stub
return null;
1
¥

Figure 6.5. Converter Class

Now you are able to add a business logic of converter in the Java editor.

6.2. Create and Register a Custom Validator

It's also quite easy to develop your own custom Validators. You should perform the actions similar
to the previous one. Go through the following steps:

« In the Project Explorer view open faces-config.xml and select Tree tab.

50
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2 faces-conigami 21 ~ =

Faces Config Editor

= faces-config = Validators
= B faces-config.xmi id class Add. ..
2] Application

= Compaonents
L Converters

I & Managed Beans
g Navigation Rules
53 Referenced Bean:
7 Render Kits

T+ Validators

[<] 1 1)

Diagram Tree | Source

Figure 6.6. Validator in Faces Config Editor

* Select Validators and click on Add button.

« Type the name of your validator in the Validator-id field and name of the class for validators.

After clicking Finish button your custom validator is registered under the entered name.
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£ Add Validator x

Validator @

Validator-id:* | MyValidator |

Vali r-Cl ¥ [test.CUsmmvalluatar ] Browse._. |

(i) Einish || Cancel F

Figure 6.7. Adding Validator

Now you can create the "validator" class.

 In the Validator section you can see your Validator-id and Validator-class. To generate the
source code click on Validator-class.
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Faces Config Editor

- faces-config
= A Faces-config Xmi*
2 Application
5 Companents
¥ Converters
b L& Managed Beans
L Navigation Rules
5% Referenced Bean:
7 Render Kits
= % Validators

& MyValidator

[<] I | D

[+

~ Validator
Validator-id: |Myvalidator |
@ ’test_t:ustom‘u'alluatur H Browse... ]
Description: E 3
al il [+]
- Attributes
name class Add...

~ Properties

Diagram Tree | Source

Figure 6.8. Creating Validator Class

» Java class will be created automatically. Leave everything without changes and click Finish.
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4 New Java Class x
java Class
Create a new Java class. Q
Source folder: [JSFPrujchJavaSuun:E ] [ Browse... I
Package: [test ] Browse.. .

[] Enclosing type:

Mame: [Cusn:rm'l.falidatnr
Madifiers: 3 public () default
[] abstract [] final
Superclass: [jaua.lang.ﬂbject ] [ Browseg... I
Interfaces: Add...

Which method 51.1.|b5. would you like to
[] public static void main(String[] args)
Constructors from superclass
Inherited absiract methods
Do you want to add comments as configured in the properties of the current project?
[ Generate comments

] [ Einish H Cancel l

Figure 6.9. New Java Class Form

» To open validator class click again on Validator-Class link in the Validator section. Now you
are able to write a business logic of validator in the Java editor.
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8 races-conngxm |0, =)

package test;

“import javax.faces.component.UIComponent;

import javax.faces.context.FacesContext;

import javax.faces,validator.Validator;

import javax.Taces.validator.ValidatorException;

public class CustomValidator implements Validator

{
public CustomValidator()

i |  super (); =
ﬁ S/ TODD Auto-generated comstructor stub
}

& public void validate(FacesContext argd, UIComponent argl, Object arg2) throws
ValidatorException

i
] F/TODD Auto-generated method stub =

¥

al il 0|

Figure 6.10. Converter Class Editing

6.3. Create and Register Referenced Beans

Creation of Referenced Beans is similar to creation of Custom Validator as well. To perform this,
let's walk through the necessary steps.

« In the Project Explorer view open faces-config.xml and select Tree tab.
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| —

Faces Config Editor

= faces-config ~ Referenced Beans

name class | Add...

= f Faces-config xmi

@ Application

5 Companents |

¥ Converters |
|
|

I & Managed Beans
L Navigation Rules

& Referenced Beans

7 Render Kits
I = validators

[+] I D]

Diagram Tree | Source

Figure 6.11. Referenced Beans in Faces Config Editor

* Select Referenced Beans and click on Add button.

« Type in the name of your Referenced Bean and type in or select Referenced-Bean-Class by
using Browse button.
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f

Referenced Bean

Befersn - -

Add Referenced Bean

o

Referenced-Bean-Name:# |H}rFl.eferencedEean

| e [tESt.F'.E-TEfEHCEdBEBI‘I

] Browse._ |

Finish

|| Cancel }

Figure 6.12. Add Referenced Bean

 Inthe Referenced Bean section you should see your Referenced-Bean-Name and Referenced-
Bean-Class. Click on the link to open the Java creation wizard.
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o

. faces-connigxm &3

Faces Config Editor

= faces-config

= A Faces-config xmi
2 Application
5 Companents
5 Converters
I & Managed Beans
L Navigation Rules
= L3 Referenced Beans

= MyReferencedBean
71 Render Kits
b & validators

[+] i I+

~ Referenced Bean

Referenced-Bean-Name: |Myﬂererenc edBean

|test_R.ererencedBean “ Browse... ]

Description;

g

+ Advanced

Id:

Display-Name:

|
|
Small-lcon: I
|

Large-Ilcon:

Diagram Tree | Source

Figure 6.13. Create Referenced Bean Class

» Java class will be created automatically. Leave everything without changes and click Finish.
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¢ New Java Class

java Class

Create a new |ava class.

€

Which method stubs. would you like to
[] public static void main({String[] args)
Constructors from superclass
Inherited absiract methods

[ Generate comments

Source folder: [JSFFrujchJavaSuun:E ][ Browse... I
Package: [t-est ]
[] Enclosing type:
Mamme: [Heferencedﬂean
Madifiers: 3 public () default

[] abstract [] final
Superclass: [jaua.lang.object ] [ Browseg... I
Interfaces: Add...

Do you want to add comments as configured in the properties of the current project?

[ Einish || Cancel i

Figure 6.14. New Java Class Form

» To open Referenced Bean class click again on Referenced-Bean-Class in the Referenced
Bean section. Now you are able to write business logic of Referenced Bean in the Java editor.
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B racescomgxmi | D\Suumea et

package test;
public class ReferencedBean {
& public ReferencedBean() {

S/ TODD Auto-generated comstructor stub

}

1] I

Figure 6.15. Referenced Bean Class Editing
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Chapter 7.

JSF Project Verification

In this chapter we'll discuss a possible verification that you can take advantage of.

Many different rules are checked for a JSF project that can be configured by selecting Window >
Preferences from the menu bar, selecting JBoss Tools > Web > Verification from the Preferences
dialog box and then expanding the JSF Rules node.

£ Preferences X
[type filter text | Verification o
= |Boss Tools 0 —
1| | Rules Confi ural:lnn|:::- uuns] —
[F |Boss Servers 9 i
Packaging Archives Verification Level: [an'_.r ' -
= Web -
= [ |SF Rules
b Editers
b s [ Check Faces Config Application Attributes
|| b Check Faces Config Companent Attributes
b seamn
[ Check Faces Config Converter Attributes
b Strues
— b Check Faces Config Factory Altributes
i
P Check List Entries Attributes
I+ XDoclet
A B Check Managed Bean Altributes
[ Check Managed Property Altributes
B Mylyn 9 perty
B Check Map Entries Attributes
b Plug-in Development
[ Check Navigation Rules
b Run/Debug
B Check Phase Listener Attributes
b Server
[ Check Referenced Bean Attributes
I+ SQL Development -
P Check Render Kit Attributes
b Teamn
- I Check Renderer Altributes =
Validation £ =
al ) | Gl v
(i3] oK | [ Cancel }

Figure 7.1. JSF Rules

Suppose you are working in the Source viewer for a JSF configuration file as shown below:
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<7xml version="1.80" 7= =
<!DOCTYPE faces-config FUBLIC *-//5un Microsystems, Inc.//DTD JavaServer Faces Col
"http://java. sun.com/dtd/web- facesconfig_1l_l.dtd" >

<faces-configs=

=managed-bean>

<managed-bean - name>pe rsonBean</managed- bean - nama>
E <managed-bean-class>jsfHello.PersonBean</managed-bean-class>

=managed-bean - scope=request</managed- bean- scope>

<managed-propertys

<property-name=name=/p roperty-name:=

<yalue/>

</managed-property=

=/managed-bean>

=navigation- rule=

=from-view-id=/pages/inputname. j sp=/from-view- id>

=navigation-casex>

=f rom- ou tcome=greeting<,/T rom- outcomes

=to-view- id=/pages/greeting. jsp</to-view- id=

</navigation-cases

=/navigation- rule>
</faces-config=>

[+ ' Iv)
Diagram | Tree Source

[l

Figure 7.2. Faces-config.xml File

While typing a class name, you might make a minor typo (like "jsfHello.PersonBean9" instead
of "jsfHello.PersonBean" ). After saving the file, verification checks to make sure everything is
correct and finds the error below:

P (2 META-INF
i I <faces-configx)
b i pages | <managed-bean>
| <managed- bean - name>personBean</managed- bean-name=
_ =managed-bean-class=]sfHello, PersonBean9=/managed-bean-class=
& lib | <managed-bean- scope>request</managed-bean- scope=>
o faces-config.xmil <managed-propertys=
. roperty-names=name</prope rty-names
2 web . xmil ?;alﬁe',;_y property
i index jsp </managed-propertys

=/managed-bean>
<navigation-rule=

Figure 7.3. Error in Source View
Notice that the Package Explorer View shows a marked folder and a marked file where the error is.

You can place the cursor over the line with an error message and get a detailed error message:

B <faces-configs
=managed- bean=>
=managed- bean - name=parsonBean</managed- bean - name:=
IEH’CII': Atfribute managed-bean-class references to non-existent class isﬂ-lelln.mrsnnﬂeangl
=managed-bean - scope>request</managed- bean - scope>
=managed-prope rity=
<property-name>nameé</prope rty-name:

Figure 7.4. Error Message
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Verification also checks navigation rules:

=managed-property=
<property-name>name-</property-name>
=value/=
=/managed-property>
</managed-bean=>
<navigation- rule=
=from-view-id=/pages/inputname. j sp=</from-view-id>
=mavlgatlon-Ccases
=from- outcome=greeting</f rom- outcome=
<to-view- id>/pages/greeting. jsp=</to- view- id=>
=/navigation-cases>
=/mavigation- rule>
</Taces-conTig=

[+

Diagram Tree Source

(o]

Figure 7.5. Checking Navigation Rules

If you provide a page name that does not exist, verification will let you know about that:

P = ant | <value/>
</managed-property>

= {3 WebContent
=/managed- bean>

b = META-INF <pavigation- rule=
b g pages <from-view- id=/pages/inputname. jsp</from-view- id=
! <navigation-cases

&b jLx} <to-view- id=/pages/qreeting-old. jsp</to-view- id=
) </navigation-case=
gkl Faces-config.xmi </navigation- rule»

=1 web. xmil </Taces-config>

Figure 7.6. Page Name Verification

You can always call up verification explicitly by right-clicking any element in the tree and selecting
Verify from the context menu. This works from both the Tree and Diagram viewers for the JSF
configuration file editor. You can also invoke verification from the Web Projects view. Below we

are checking all of the elements in the configuration file.
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|1 races-config.xml &3

Faces Config Editor

- faces-config - Application
= A faces-config.xmil r Action-Listener
|
= Compaoner New i
L Converter: £
= @ Managed E Edit..
b @ user
= L Navigation
b & jpages
& Reference

[ Copy Ctrl +

L Render Kit!  Properties...

& Validators g
-

Diagram Tree  Source

Figure 7.7. Verify Command

In summary, this document highlights all the JSF-specific features of JBoss Tools meant for
enhancing the development of rich Web applications based on JSF technology. The reference
introduces you to wizards for creating and importing JSF projects, JSF Configuration File editor
features, functionality for enabling JSF capabilities and etc.

If you have questions or good suggestions, please refer to JBoss Tools Forum [http:/
www.jboss.com/index.html?module=bb&op=viewforum&f=201].
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